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Introduction 
 
The Office 365 migration is a countywide initiative to move from the current Microsoft infrastructure to 
the Office 365 cloud-based environment. This project is to be conducted in phases the first phase being 
Outlook mailbox migrations, the second phase being Office applications migrations, and another phase 
for other items which need to be addressed. 
 
For each phase of the project a guide will be created which covers the specifics associated with 
migrating that particular type of application and its associated data. 
 
 

Phase 1 Migration Description 
 
The phase 1 Office 365 migration is focused around moving the Outlook exchange mailboxes and 
associated information from local servers to cloud-based servers. In this process the mail stores which 
would include messages, contacts, schedule items, and tasks would be moved by DTS in conjunction and 
with coordination by the departments. 
 
Additional files such as PST's, and Public Folders will be addressed by your team in conjunction with staff 
from your department and using instructions which are found in this manual. 
 
There are two major groups within your department which will be migrating. 
 

• Those staff who are using office 2003 
• Those staff who are using office 2007+ 

All Office 2003 products are at end of life technically and no longer supported.  Therefore those who use 
the Office 2003 products those staff will discontinue use of the desktop-based versions of the software 
in favor of accessing web-based replacement software. For example those who use Outlook 2003 on the 
desktop today will be using Office 365 OWA on the Internet once migrated. 
 
For those staff that is using Office 2007+ products their mail stores and associated data will be moved 
from the local environment to the cloud however they will continue to use their current desktop 
versions of software. The only difference will be that PSTs are read-only. << VERIFY >> 
 
 
 

Planning for the migration 
 
Migrations will occur in groups where numbers of departments will be migrated together during the 
same migration event. To facilitate this migration groups are being formed based on various 
characteristics associated with the departments and their interaction and interdependency with other 
departments. 
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Your teams role 
 
You and your team play key role in the migration activities as you understand your client base better 
than anyone else in the County. As such you understand how to motivate them to take training and 
participate in things such as reviewing Public Folders and PST. 
 
DTS and the local IT department contacts form the on-site migration teams that will help each of 
migration groups successfully complete their activities and monitor their operations for.  
 
We need your wisdom and your enthusiasm to support this activity. Will be working with you and your 
team provide training and share the timeline for migrations. Within your department you need to plan 
for migration in a number of different ways to include: 
 

1. Clean up unused mailboxes and resources such as Public Folders. 
 

2. Identify those special mailboxes which need to be retained i.e. ESB has mailbox that send out 
notifications of transmission activities 
 

3. Work with staff, (especially those who use Office 2003 Outlook), to ensure that they've taken 
the training tutorials and have used the UPK tools prior to migration so that when they arrive 
after migration they can perform the basic functions needed to continue operations. 
 

4. Help identify special cases of PST's and a strategy to move the PST's for those staff who have 
multiple ones. 
 

5. Provide support during the migration to help field questions from your staff in the department 
regarding basic activities associated migration remember the user interface will change 
dramatically for the Office 2003 users. 
 

6. Determine the relevancy of Public Folders for the department and indetify those whos data will 
need to be moved into Office 365. 
 

7. << VERIFY >> If we need other things from the onsite teams 

 
As soon as a migration date has been set for a migration event, all impacted departments will be 
notified (4 weeks before the migration date) 
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What we need from you and your team: 

• Confirmation of the data we have collected indicating the split between Police staff with 
different software versions 

• Information regarding staff who have multiple PST files so that we can determine how best to 
migrate them. 

• Local assistance ensuring that Police staff review the tutorials and are guided there after 
migration before calling the help desk 

• Coordinating and supporting post migration recuperation activities   

What we need 
 

1) You and your teams’ support for project and timeline 
 

2) Data about your department 
a. VPN use and special considerations 
b. Identification of both staff primary PST and those staff with multiple PSTs 
c. Special configurations which use Outlook or exchange server 
d. Outlook add-ons (connectors, converters, etc.) 
e. Identification of mail enabled applications 
f. Identification of specific Public Folders to migrate and all security permissions 

associated with them 
 

3) Resources from your team during roll-out (still being defined by to include) 
a. Direct trouble shooting with individual staff from your department 
b. Training assistance to ensure your Departments staff has seen the tutorials 
c. Moving Public Folders as required 

 

 
4) Tutorials are a key success factor in this project. It is critical that the Department staff access 

and review these early and often until they are migrated.  Once migrated that can only operate 
in the new environment. 
 
The team is constructing tutorials in both PowerPoint storyboards and video format.  These will 
be provided in a readily accessible area and we need your help in encouraging department staff 
to go online and review the tutorials.  There are 10 tutorials at this point which represents about 
30 minute’s total time to view them.  Staff should be able to wok that into their schedules 
before the migration and worst case if they did not look at them before that can review them 
after they migrate. 
 
 

5) Feedback from you 
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Staff Training  
 
One of the key activities associate with this migration is to train the staff about what they should expect 
once they have been migrated. For the office 2007+ staff the transition is not very dramatic as most the 
activity is pointing their data to cloud storage rather than local storage. 
 
In the case of staff using office 2003 applications the change is much more dramatic. All the Office 2003 
desktop agents will stop working once they have been migrated to the cloud. To replace them Microsoft 
provides a series of cloud-based applications that provide similar capabilities. In the case of Outlook 
2003 the cloud alternative is the OWA.  OWA is very different than the one in use today and staff will 
need a bit of assistance to navigate and use it initially. 
 
Migrations are divided into migration groups which consist of groups of departments (except for very 
large departments such as HHS). These migrations occur on a regular schedule of a group every week or 
two.  The timeline for preparation for a given migration is roughly a month. This means your department 
will begin the migration activities in earnest one month before the actual migration is scheduled to 
occur.  
 
 

Tutorial approach 
 
In order to successfully migrate the 10,500 staff that need to move training has to be handled a very 
expeditious manner. Of those who are being trained the 2003 products staff are the ones which need 
the most help as their user experience will change dramatically between what they currently have and 
the Office 365 implementation. 
 
For each phase of the migration a series of key Office related activities have been chosen and then 
training in the form of tutorials will be created to show the staff how those functions work. For example 
creating and sending messages is a key activity of the mail system so consequently one of the tutorials 
describes how that's done. 
 
In total there are eight Outlook tutorials one to cover the Chrome browser as that will be the main 
browser), and one for staff using Office 2007+ to show the differences post migration. The tutorials are 
being rendered out in three different ways but conveying exactly the same messages the matter which 
method is being used.  
 

• POWER POINT: In one form they are PowerPoint storyboards which are screenshots with 
descriptions embedded in them to allow the user to read along and view the interface in a static 
manner but letting then understand the various elements available. 
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• VIDEOs: Another form are videos which use the PowerPoint storyboards as a baseline only they 
actually walk through the product in animated fashion with voiceovers describing the various 
activities. 

 
• UPK: In the third form a User Productivity Kit (UPK) will be created for each of the major tutorial 

activities and therefore the staff can use the UPK to walk through the product in a safe and non-
production mode. This is important as it enables the staff to practice the activities. 
 
Note: These tools will address ADA compliance with closed captioning 

 
The form which the tutorials take is targeted to be roughly 5 to 7 min. each and structured in a manner 
that staff can take them in any order, repeat as many times as they want, and review them again and 
again. 
 
 
 
 
 
 
 

 

Browser Handling 
 
The office 365 approach to browsers has a lot to do with the operating system on which the desktops 
are running. Within the universe of systems and operating systems in the County there are roughly 2100 
XP based users. 
 
XP – Operating System 
In the case of XP based systems that need access to OWA, the recommendation is that the County will 
use Firefox as its alternative browser. Firefox is a good alternative as it also works well with the ERP-
based solutions such as BI tools and staff self-service. 
Firefox will be deployed to the staff with XP based systems prior to migration but not associated with 
the OWA icon until it is time to migrate that department. 
 
Windows 7 – Operating System 
For the Windows 7 based systems the IE browser is supported by Office 365 and thus OWA will operate 
with it. No alternate browser is needed or will be deployed.  
 
Desktop Icons 
Because of the association of OWA with a particular browser or the Office 365 migrations there will be 
two desktop icons deployed.  
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• For staff using Office 2003 with the XP Operating System the OWA Icon will associate OWA to 
the Firefox bowser. 
 

• For staff using Office 2003 with the Windows 7 Operating System the OWA Icon will associate 
OWA to the IE browser. 

The icons will have an association with the browser by including the browser logo as part of the icon.  
Staff that has these desktop icons will have only one on any given machine to address the particular 
Operation System / Office 2003 combination 
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Working with PST files << VERIFY >> 
 
Among the areas that have potential challenges for the migration are the management and movement 
of the PST files associated with e-mail accounts. Most all e-mail accounts have PST's although it's been 
noted that in certain departments certain staff will use some form of remote access and therefore are 
not likely to have them. 
 
On the other extreme there are power users within the County that have multiple PST's. Our challenge is 
to determine which PST's need to be moved when the mailboxes migrated and to take care that move.  
Then we need to provide tools to allow you as the Department IT contacts to help facilitate the 
movement of the remaining PST's should the staff members desire that. 
 
There will be tools which will help determine the number of PST's but at this writing there is no 
determination of which PST is actively associated with a given mailbox. 
 
For those 2007+ users the PST situation is a lot less complex. After those users migrate the PST's they 
had before will still be available in their mail store however they point back to the old PST location and 
be read only. During the follow-up activity staff will drag and drop the PST's into their cloud-based file 
store for messages and folders which will then be reconciled and become accessible from anywhere. 
 
NOTE: There will be a hard deadline for all data associated with Outlook in the current operating 
environment. Departments will have sufficient time to complete whatever follow-up tasks are required. 
Once the deadline date is reached desktop versions of 2003 product will be removed and within the 
actual local County mail stores file such as PST's and Public Folders will be eradicated permanently. 
 
 

PST Handling 
PST handling appears to be very challenging and so far consultants who done migrations have not 
migrated many PST's. As with other parts of this project there are two PST approaches based on which 
versions of Office staff are running. 
 
Part of the challenge of the PST's is it takes roughly dirty to 60 min. to move any given PST. Given the 
bandwidth between the County and Microsoft cloud it's unknown how rapidly PST moves can be 
achieved. Another part of the challenge is that there is no tool to move multiple PST. So each PST has to 
be moved individually by hand. 
 
 
Office 2003 
For the staff using Outlook 2003 their PST's will remain connected to their current desktop based Office 
2003 application. This means that those PST’s will not be migrated or are visible in OWA. Should staff 
wish to view the PST’s they would need to go to their desktop version of Outlook 2003 to access them. 
They can only be accessed in ‘read-only’ mode.  
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In the event that staff wishes to have their PST data moved to the cloud and accessible via 0WA then 
they need to contact their local IT staff and request that the PST be moved. The local IT staff using tools 
provided by DTS will be able to move the PST's one at a time. 
 
Office 2007 
For staff using Office 2007+ it will be business as usual after migration with respect to PST's. The PST 
infrastructure will be maintained as is and only the mailboxes of the 2007+ staff will be moved. Staff will 
access their PST's as they usually do via their desktop agents for the software.  
 
Should they desire to move the PST's into the cloud for more global access and to prevent them being 
deleted when the PST's or removed from the current of the structure staff will be able to drag-and-drop 
them themselves. 
 
Once the staff drag-and-drop there PST's into the cloud mailbox store they'll be safe from being deleted 
when the PST is removed from the current of the structure. They will also be accessible globally from 
wherever the user may be. 
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Addressing Virtual Private Networking (VPN) Specials 
 
Virtual Private Networking (VPN) is a capability which is used in a number of situations across the 
County. At last count there were over 3,000 VPN users using a variety of different kinds of applications 
which require the VPN. 
 
For those staff that are required to use cloud-based versions of office 365 software such as OWA 
Internet access is required. Part of VPNs security is in certain circumstances to block Internet access. So 
long as these security features have been activated its expected that the staff person can use the VPN as 
they normally do to access the Office 365 cloud-based applications. 
 
There is one known exception which is the Network Connect feature VPN users to establish further 
security for certain types of applications (such as the new Web content management system CMS). 
When the VPN has network connect feature invoked it will create a secure environment such that no 
Internet access is possible. 
 
During the early stages of migration when you conduct the analysis of your department, keep a record 
of VPN users who use the Network Connect feature in order to conduct their business.  We will need to 
determine a solution for those users. 
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Working with Public Folders 
 
During the mid-2000 Public Folders became a popular method to hold certain types of information 
which are hard to manage in the conventional mailbox approach. Things such as calendars for 
conference rooms were put into Public Folders before the “resource” capability of Outlook became 
readily available. 
 
Last inventory of Public Folders indicated a total of 3112 in the County. Of these hundreds are empty 
and thousands have not been used since November last year. There are roughly 120 folders in use today 
across a number of departments. Departments are encouraged to review the  
 
Given this information we still reach out to departments and requested a review all the Public Folders to 
ensure that they have not missed something that they want. We recommend that they moved the 
Public Folders only after they have coordinate with their department staff and determine the best use of 
this particular kind of data. 
 
Note: Once the data eradication activities begin any remaining un-migrated Public Folders will be 
permanently eliminated  
 

BIT (4) CCL (1) 
CEC (2) CFW (3) 
DGS (5) DLC  (1) 
DOCR  (19) DPS (1) 
FIN  (7) FRS  (3) 
HHS  (20) MCG  (1) 
OCA  (1) OCP  (2) 
OEMHS  (4) POL (21) 
REC  (1) SHF  (4) 

 

Table 1 – Public Folder – Departments with active Public Folders as of (4-30-14) 
 
 

 

 

Reconciling the data from Public Folder into Office 365 
 
Data from the current Public Folder structure will be migrated into one of three types of solutions 

1) Share Point 
2) Shared mailboxes 
3) Resource mailboxes 

a. Room mailboxes 
b. Resource mailboxes 
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Various data types from existing Public Folders will reconcile in various ways please refer to table. 
 
 

Data Type Office 365 Solution 
Calendar (Conference room) Resource - Room Mailbox 
Projector Resource - Resource  Mailbox 
Messages Shared Mailbox 
Contacts Shared Mailbox 
Tasks Shared Mailbox 
Documents Share Point (MOSS) 

 

Table 2 – Public Folder - Office 365 solutions 
 
 
 
It is the responsibility of the Department IT staff to establish the proper permissions based on 
coordination with department staff for all the Public Folders they decide to maintain. 
 
 

Public Folder FAQ’s (provided by Microsoft) 
 

- When a user moves to OWA and there are Public Folders in the old mail server infrastructure 
can they still access them? 

o This depends on how the existing environment is configured.  There are certain 
requirements in Hybrid configuration that must be followed to allow users in the cloud 
to see on premise Public folders.  As defined at: http://technet.microsoft.com/en-
us/library/dn249373(v=exchg.150).aspx 
 

- Correspondingly, in the new Office 365 environment how does one see the equivalent of 
Public Folders? 

o An example of accessing the Public Folders can be found in this blog post: 
http://blogs.technet.com/b/lystavlen/archive/2012/07/18/public-folders-in-office-365-
preview.aspx  
 

- Are shared mailboxes and resource mailboxes the same? 
o No, while they both do not require a license they operate differently within 

exchange.  Resource mailboxes are geared more towards management of resources like 
conference rooms so their configuration allows them to appear in certain interfaces 
within Outlook and Outlook Web Access compared to a Shared Mailbox which simply 
acts like any other mailbox. A Good introduction to resource mailboxes can be found at: 
http://exchangeserverpro.com/exchange-server-2013-room-equipment-mailboxes/ 

http://technet.microsoft.com/en-us/library/dn249373(v=exchg.150).aspx
http://technet.microsoft.com/en-us/library/dn249373(v=exchg.150).aspx
http://blogs.technet.com/b/lystavlen/archive/2012/07/18/public-folders-in-office-365-preview.aspx
http://blogs.technet.com/b/lystavlen/archive/2012/07/18/public-folders-in-office-365-preview.aspx
http://exchangeserverpro.com/exchange-server-2013-room-equipment-mailboxes/
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- Are there limitations in numbers of mailboxes? 

o NO 
 

- Can staff update then directly or do you need special admin access 
o Admins manage their properties but control can be delegated to staff directly 

 
- Are all folder permissions transferrable to the mailbox and MOSS configurations? 

o This answer truly depends on current configuration and methods used for 
migration.  This would likely be better answered by the partner you would be working 
with once topology is determined. 
 

- If I am an Office 2007+ user and I have been migrated. Would I still see Public Folders that still 
existed in to old environment? 

o This again depends on how the environment will be configured.   
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Office 2003 retirement 
 
There'll be a period of time after the last migration when the PST file will be maintained in the current of 
the structure the kit. It's anticipated that this of the roughly 6 to 12 months. During that time staff are 
encouraged to determine if they need there PST's and which PST they may need and to coordinate their 
moves if they're not able to move themselves. 
 

 

 

Migration Timeline 
 
Migrations will occur on a regular basis with groups of departments being migrated simultaneously. On 
Thursday night of migration week that department staffs that were scheduled for migration will have 
their mailboxes moved behind the scenes such that that Friday morning they will see and be pointed to 
the new Office 365 environment. 
 
The pre-migration activities span across four weeks. There are number things which will be documented 
and shared to assist IT contacts working with your department staff to finish the various tasks prior to 
migration and then perform the required tasks to move the remaining information you desire to keep. 
 
During week three of the migration timeline all staff will have completed training through the tutorials. 
A live demo and Q&A session which of the hosted for those staff desiring that form of training.  
 
There will be a series of activities post migration that every staff member should perform such as 
rebooting their machines. (Checklist to be provided) 
 
 

Typical Migration Flow 
 
 

Event  Day  Description Who Does  

    
  

Pre Migration  
 

    PMGE-1 TBD Postmaster Global Announcement (All Employee) 
 PMGE-2 -30 Directors Notification (One instance) (Email) DTS 

PMGE-3 -30 MLS Notification (One instance) (Email) DTS 
PMGE-4 -14 All Tech Lead Migration Briefing  DTS 
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Week - 1 
 

MGE-1 1 Launch Notice to Department Staff of Migration Group  
Department Tech 
Leads 

MGE-2 1 Migration Group Staff Training MG - Staff 
MGE-3 2 Migration Group Staff Training MG - Staff 
MGE-4 3 Migration Group Staff Training MG - Staff 
MGE-5 4 Migration Group Staff Training MG - Staff 
MGE-6 4 Pulse check with migration group tech leads DTS - MG-Tech Leads 
MGE-7 5 Migration Group Staff Training MG - Staff 

    
  

Week - 2 
 MGE-8 6 Migration Group Staff Training MG - Staff 

MGE-9 7 Migration Group Staff Training MG - Staff 
MGE-10 8 Migration Group Staff Training MG - Staff 
MGE-11 9 Migration Group Staff Training MG - Staff 
MGE-12 10 Migration Group Staff Training MG - Staff 

    
  

Week - 3 
 MGE-13 11 Final Prep Notice to Department Staff of Migration Group  DTS  

MGE-14 11 Migration Group All - Final Prep DTS / MG - All 
MGE-15 12 Migration Group All - Final Prep DTS / MG - All 
MGE-16 13 Migration Group All - Final Prep DTS / MG - All 
MGE-17 13 Readiness review DTS / Tech Leads 
MGE-18 14 Migrate - Migration group All DTS 
MGE-19 15 Recovery Room for Migrated MG DTS / Tech Leads 

    
  

Week - 4 
 MGE-20 16 Recovery Room for Migrated MG DTS / Tech Leads 

MGE-21 17 Recovery Room for Migrated MG DTS / Tech Leads 
MGE-22 18 Recovery Room for Migrated MG DTS / Tech Leads 
MGE-23 19 Recovery Room for Migrated MG DTS / Tech Leads 
MGE-24 19 Send Migration Close out message & survey DTS      
MGE-25 19 Check with L3 regarding trouble ticket trends DTS      

 
 

Post migration items 
 
Once the migration is complete the staff will access their messages contacts tasks and other items 
associated with their mailbox. Staff will use the mailbox to communicate following those instructions 
provided by the tutorials. 
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As the IT contacts of the department you have some follow-up tasks which need to be performed 
primarily focused around Public Folders and PSTs. 
 
 

PST finish up 
 
The PST finish up activities are associated with moving or shifting staff to move those remaining PFTs 
which you wish to preserve from the current server-based environment into a cloud-based solution. This 
is still being finalized and will be part of the final documentation 
 

(More to be added once details are known) 
 
 
It is expected that most of the city activity PST activity will be associated with the 2007+ staff as they're 
more likely to have multiple PSTs. 
 
 
 

Public Folder finish up 
 
In the event that there are still Public Folders which have not been moved prior to the migration and 
wish to be preserved then you as the IT department contacts will need to work with your local staff to 
determine which ones they are and then to implement them in there is a resource or shared mailbox or 
in the case of documents share point. 
 

(More to be added once details are known) 
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How Do I? 
 
In order to successfully migrate the 10,500 staff that need to move training has to be handled a very 
expeditious manner. The following section describes how specific activities are addressed. As details 
emerge from the pilot and early migrations this section will continue to be refined. 
 

(More to be added once details are known) 
 

Determine which version of office a staff member has 
 
One of the first steps in migration is to ensure that various staff are reading and reviewing the material 
associated with the particulars of their migration 2003 or 2007+. 
 
It is not possible to send separate messages to the staff with different various versions of Office.  All 
communications will include both with references as to which parts to concentrate on based upon 
version. 
 
Microsoft has provided instructions for determine which version of office (please see Appendix B) 
 
 

 

Handle PSTs 
 
In many cases staff will have multiple PST folders.  The migration team is working to move the primary 
PST and moving it as part of the migration.  Any additional PST moves will be handled using the 
following instructions.   
 
 

Finding PSTs 
 
The first step of the process is to locate all PSTs that a staff person can have.  It is likely that the 2007+ 
version users are likely to have multiple PST files although there are some limited reports of 2003 
version users with multiple PSTs. 
 
One of the main issues associated with locating PST's is to determine the main PST that's used with the 
mailbox. Once this has been determined that PST would be the one that would be moved along with the 
mailbox stores. 
 

(More to be added once details are known) 
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Moving PSTs 
 
Once identified the staff would use one of two approaches depending upon which software staff person 
was using at the time of migration. 
 

- For staff using office 2003 software … 
- For staff using office 2007+ software … 

 

(More to be added once details are known) 
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Handling Public Folders 
 
Public Folders were a method to allow staff to access various types of data which staff needed access to. 
In many cases, data such as room schedules and message traffic archives where maintained. 
 
The County has 3112 Public Folders which represented all folders from all departments.  In November of 
2013 all the Public Folders were moved to a new server and the “last change” date was reset to that 
accordingly. 
 
Since then less than 200 folders have been access and updated.  There are at least 700 empty folders 
and the lack of activity implies that these folders are not being updated any longer. 
 
 

Determining which Public Folders should be migrated 
 
First, Department IT contacts must determine the status and need for the things that required Public 
Folders. 
 
In many cases, the Public Folders had been established to handle things which were difficult to do in 
earlier versions of Outlook. These functions are either no longer required or being handled through 
other accommodations within the newer version versions about of Outlook. 
 
Since not all data is still pertinent this should be an opportunity to clean up the public folder 
environment. 
 
 

Moving Calendar Data 
 
 
Calendar data is used both for recording events which occurred on the calendar and in some cases to 
schedule resources such as conference rooms. 
 
In the event the data is for a conference room then a resource mailbox in Outlook 365 is the solution. 
You'll need to allocate one mailbox for each calendar that will be supported.  
 
In addition, resource mailboxes actually have two types of resources they manage.  

1) Resources - such as conference room.  
2) Equipment - for things such as projectors. 

Once the calendars have been moved and the appropriate mailboxes in Outlook 365 the permissions 
required within the department to support who can perform what functions needs to be defined. 
 
 

Moving Messages 
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Mail messages require a mailbox to be stored. Very similar to scheduling in order to store the messages 
in Public Folders these messages would require a shared mailbox to store them in the Office 365 
environment. 
 
Once moved into this shared mailbox appropriate permissions will be required to allow authorized staff 
to access this mailbox. 
 
 
 
 

Moving Task Lists 
 
A Task list is very similar to messages and is considered a mailbox-based item. In the case department 
wants to save tasks in office 365 as they had in with Public Folders they will need to have a shared 
mailbox and then move the Tasks into the shared mailbox following the following procedure. 
 
Once the tasks have been moved the appropriate shared mailbox permissions should be provided for 
those staff that should be authorized to access that information. 
 
 

Moving Contacts 
 
Much like schedules, messages, and tasks contacts are part of the mailbox structure and will need to use 
shared mailboxes to preserve the contacts. 
 
Once the data has been put into the shared mailboxes the IT contacts will provide permissions required 
so the data can be shared amongst those authorized users.  
 
 

Moving Documents 
 
Documents are a different category of data. In the Public Folder context, data was stored in the native 
form such as a word document. In the Office 365 environments there is no specific corollary to that with 
the exception of SharePoint. 
 
For those documents which departments wish to preserve in the Office 365 environment and share in a 
similar fashion a structure needs to be established within the Share Point that support these data and 
these documents.  
 
It is very important that time is spent in creating the appropriate data structures within SharePoint to 
support the data which the department desires to have available.  
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Addressing VPN Special Situations 
 
Virtual private networking or VPN is used to provide a secure path through the Internet to allow access 
certain kinds of applications while staff is remote. Office 365 does not require VPN access to reach and 
use the various cloud-based applications. 
 
In the case where a staff person is using VPN for other access requirements and wishes to access office 
365 cloud-based tools they should be able to do this via “split tunneling”. In split tunneling there are two 
titles created in VPN one which is a cure tunnel those data which required and the other which is an 
open channel for pure Internet access 
 
In some cases certain features of VPN will cause the split tunneling feature to be disabled and thereby 
disabling any access to the Internet. This proves very problematic for that staff that are using cloud-
based applications exclusively.  
 

(More to be added once details are known) 
 

Determining if there are VPN challenges 
 
The VPN has many different features and capabilities one of which is called Network Connect. The 
network connect feature allows for access to certain kinds of application which require more intense 
access then pure file storage would. 
 
In the case where network connect is used split tunneling is disabled and therefore cloud base Office 
365 applications are not accessible. In other cases there should be no issues with running VPN and 
cloud-based Office 365 applications.  
 
 

Addressing Challenge n 
 
 
The first step of … 

(More to be added once details are known) 
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Mobile Devices 
 
The following section describes how specific mobile device activities are addressed 
 
The approach should be, we don’t migrate any Department staff to O365 that is not in full security 
training compliance yet.    It is up to the Dept and/or Security Team and/or OHR to trace after any NEW 
employee/contractor/volunteer/intern/Partner/somewhere in between. 
 

Proposed Mobile Device Rules 
 

1) All mobile devices such as IPhone, Androids, etc. that access County systems must be protected 
with a PIN or other login password 
 

2) You must report lost or stolen mobile devise which access Count Systems to the Helpdesk AS 
SOON AS POSSIBLE. This includes devices that you own! 
 

3) Sensitive information stored on such devices must be encrypted, including email messages. 
 

4) Consult with your supervisor if you are unsure of what type of information you may store on 
your mobile device 

 

Approach for re-validating Mobile devices 
 

1)  All Mobile devices will be set to ‘off’ for validation. 
2) All Mobile users must have an AD account 
3) Once the staff person tries to use the Mobile with County … they will be prompted to go to a 

acceptance page 
4) At the acceptance page the system will confirm they have taken County security training 

a. If the have not taken it indicate to the user and shut down. 
b. If they have taken it go to step 5 

5) Provide details of eraser policy and require acceptance 
6) Staff person accepts policy 
7) System Sets standard parameters 

a. Pin timeout 
b. PIN 
c. … 

8) User is signed on 
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Closing Remarks 
 
All efforts possible are being made to ensure that this transition will go as smoothly as practical. There 
are a large number staff to move with a variety of different complex environments. It is challenging to 
ensure that the staff is fully trained prior to the migration however with the tools and capabilities being 
put in place we have the best chance of being successful in these efforts. 
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Appendix A - Glossary 
 
All …… 
 
 
Office 365 Services  Cloud Based services provided by Microsfot 
 
PST    Mail store facility for MS Outlook 
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Appendix B – Office 365 Service Offerings 
 
 
 
The Office 365 environments we are contacting for are: 
 

- (G1) - Basic Mail Services (Paid for by DTS)  
o 50 GB mailboxes for every user 
o Elimination of PST files; mail folders available from any device anywhere 
o Many new features/functions, including: 

 Individually controlled internal and external out-of-office messages  
 “Working Elsewhere” calendar label 

o Browser versions of MS-Word, MS-Excel, MS-PowerPoint and MS-Outlook 
o Better support of mobile devices for e-mail, contacts and calendars 
o Greatly improved Outlook Web Access (OWA) 
o 25 GB U: drive for every user 
o Searchable S:, V: and U: drives 
o Sanctioned Cloud-storage  
o Instant messaging 
o Video conferencing 
o MOSS (SharePoint)  

 
- (G3) - Additional fee items (Paid for by Departments) 

o Unlimited e-mail storage and online eDiscovery/legal hold  
o Data loss prevention (rules to encrypt, rules to prevent leakage)  
o Latest version of MS-Office on 5 devices  
o Additional network file storage  

 
 
As the contacting and such is not completed I can provide specific pricing but product literature 
indicates at the follow rates should be expected: 

- G1 Services - $6/month per user account 
- G3 Services - $17/month per user account 

Note: Additional fee items will not be offered until the Office 365 migration has been completed 
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Appendix C – What version of Office am I using? 
 
 
What version of Office am I using? 

You can use the screen captures and steps below to see which version of Microsoft Office is installed on 
your computer. 

 
Office 2003 

Office 2003 has text-based menus on the gray bar: File, Edit, View, Insert, Format, Tools, Table, Window, 
and Help. The following shows Word 2003. 

1. Click Help > About. 
2. In the About dialog box, find the version and the Service Pack (SP). Product licensing appears 

in the This product is licensed to field. 

 
Office 2007 

Office 2007 introduced tabs and the Microsoft Office Button and a tab menu. The following shows Word 
2007. 

1. Click the Microsoft Office Button  > Word Options. 

2. In the Options dialog box, click Resources. Find the version and the Service Pack (SP). 

NOTE    To learn about licensing, in Resources, click About. On the About dialog box, see This 
product is licensed to. 

 
 
Office 2010 

Office 2010 introduces the File tab and the Microsoft Office Backstage view. The following shows Word 2010. 

1. Click File > Help. 

2. Under Product Activated, find the version. 

 NOTE    To learn about licensing, see About Microsoft Word. 
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Office 2013 

The latest version of Office still uses the File tab and the Microsoft Office Backstage view. The following 
shows Word 2013. 

1. Click File > Account. 

2. Under Product Information, find the version. 

 NOTE    To learn about licensing, click About Word. 

 
Office 2013 RT 

Office 2013 RT also uses the File tab and the Microsoft Office Backstage view. The following shows Word RT. 

1. Tap File > Account. 

2. Under Product Information, find the version. 

 NOTE    To learn about licensing, tap About Word. 

 

 

===== END of DOCUMENT ===== 
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